
D. Do yourself.
E. Do yourself.

6. Paint with a Computer

A. 1. b 2. a 3. c 4. b 5. a  
B. 1. c 2. a 3. d  4. b
C. 1. computer 2. Start 3. pencil 4. Text 
5. Airbrush
D. 1. AIRBRUSH 2. PENCIL 
3. ERASER 4. BRUSH
E. 1. Pencil Tool 2. Brush Tool 3. Fill 
With Color Tool 4. Text Tool 5. Eraser 
Tool

7. Turn On and Off the Computer

A. 3,2,1,4
B. Click on Start button ……..... Switch 
off  the power switch.
C. 1. J 2. L 3. L 4. J 5. L 6. J 
D. Do yourself.

8. Responsible Computing

A. 1. b 2. a 3. c 4. b 5. b 6. c

B. 1.  2. J 3. L 4. J 5. L 6. J 7. L  

C. Do’s: You should always keep …….. it 
may damage your computer. Don'ts: You 
should not eat …………… working on the 
computer.

D. 1. c 2. d 3. a 4. e 5. b

E. 1. û 2. û 3. ü 4. ü 5. û 6. ü 7. ü 8. û

F. 1. Don’t 2. Don’t 3. Don’t 4. Do 

5. Do 6. Don’t 

G. 1. COMPUTER 2. MONITOR 

3. KEYBOARD 4. SCANNER

TECH RAY-2

1.  Computer

A. 1. b 2. a 3. c 4. b 5. a
B. 1. Fan, Television, Washing machine, 
etc. 2. A desktop computer …………...... 
fit on a desk.  3. A touchscreen is a screen 
…………. of  the tablet. 
4. Netbooks are a type of  small ……….... 
full-sized laptop. 5. Computers are 

L

TECH RAY-1

1. My Computer

A. 1. b 2. a 3. c 4. a

B. 1.L 2. J 3.  4. 

C. 1. electricity 2. fast 3. commands 

4. computer

D. 1. b 2. a 3. e 4. c 5. d

E. 1. MOBILE 2. FAN 3. JUICER

4. COMPUTER 5. CAR

2. Parts of a Computer

A. 1. a 2. b 3. c 4. a
B. 1. television 2. keys 3. Unit 4. input
5. output
C. 1. J 2. L 3. J 4. L
D. 1. COMPUTER 2. MONITOR
3. KEYBOARD 4. CPU 5. SPEAKERS
E. 1. KEYBOARD 2. PRINTER
3. MONITOR 4. MOUSE 
5. COMPUTER 

3. Applications of a Computer

A. 1. b 2. a 3. c 4. a  
B. 1. c 2. a 3. d 4. b 
C. 1. airports 2. music 3. accounts
4. shops
D. 1. ü 2. û 3.  4.  5.  6. 
E. 1. School 2. Bank 3. Hospital
4. Airport 5. Office 6. Home
F. 1. OFFICE 2. BANK 3. AIRPORT
4. HOME 5. HOSPITAL 6. SHOP

4. The Mouse 

A. 1. b 2. a 3. b 4. b 5. b
B. 1. c 2. a 3. b
C. 1. L 2. J 3. L 4. J 5. J 
D. 1. Left Button 2. Scroll Button
3. Right Button
E. Do yourself.

5. The Keyboard

A. 1. a 2. c 3. c 4. b 
B. 1. L 2. J 3. J 4. L 5. J 
C. 1. b 2. c 3. a 4. e 5. d

LL
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D. 1. second 2. Windows 3. icons 4. Start 
5. Taskbar 6. Start
E. 1. c 2. a 3. d 4. b
F. Do yourself.
G. 1. TASKBAR 2. DESKTOP
3. WINDOWS 4. START

5. Devices of Computer

A. 1. b 2. c 3. c 4. a 5. a
B. 1. Input devices are those ………........ 
to the computer. Keyboard and mouse. 
2. The input we give ………… brain of  the 
computer. 3. A monitor is one ………….... 
on the screen. 4. Storage devices help us 
………. for the future use. Hard disk and 
pen drive.
C. 1.  It is used to type letters and 
numbers ………….... monitor screen. 2. A 
mouse is a pointing device. 3. A printer 
helps ………….... on the paper. 4. It 
displays text, graphics, video information, 
etc.
D. 1. b 2. c 3. d 4. a
E. Do yourself.
F. Do yourself.

6. Working of a Computer

A. 1. c 2. a 3. b 4. a 5. b 6. a 
B. 1. F 2. T 3. T 4. T
C. 1. A computer works in three steps i.e., 
input, processing and output. 2. The 
instructions given to the computer to do a 
task are its input. The result which is 
processed by the CPU is called output. 
3. There are two types of  storage unit. 
4. Secondary storage unit ……………… 
magnetic tapes, etc.
D. 1. input 2. CPU 3. output 4. Primary 
5. secondary
E. 1. O 2. P 3. I 4. O 5. I 6. I
F. Do yourself.

7. Paint Program

A. 1. a 2. c 3. c 4. a 5. b 6. a
B. 1. Eraser 2. type 3. Airbrush 4. Curve 
5. larger
C. 1. J 2. L 3. J 4. J 5. J 6. L 
D. 1. a 2. d 3. b 4. c 
E. 1. Click on the Start button ………… 
click on Paint. 2. Firstly select the tool 

connected ……………… called computer 
networking.
C. 1. J 2. L 3. J 4. L
D. 1. c 2. a 3. b
E. 1. LAPTOP 2. NETWORKING
3. NETBOOK 4. MACHINE
F. Do yourself.

2. Parts of a Computer

A.  1. c 2. a 3. c 4. a 5. b 6. c 
B. 1. A computer has four main parts.  
Monitor, Keyboard, CPU and Mouse.
2. CPU 3. Printer 4. A web camera is a 
....…………… for video chatting. 
5. Microphone 6. Scanner
C. 1. keys 2. perform 3. colourful 4. listen 
5. computer 6. scanner
D. 1. c 2. d 3. a 4. e 5. b
E. 1. T  2. T 3. X 4. T
F. 1. MOUSE 2. KEYBOARD
3. SCANNER 4. SPEAKERS
G. Do yourself.

3. Uses of Computer

A. 1. b 2. b 3. a 4. b 5. a
B. 1. schools 2. banks 3. hospitals
4. airports 5. petrol pumps
C. 1. b 2. a 3. d 4. c 
D. 1. In schools, students learn ………… 
in different ways. 2. Computers are used in 
hospitals ............………… chemicals and 
equipments. 3. Computers are used for 
………… and aeroplanes. 4. At home, in 
schools, in banks, in offices and in 
hospitals.
E. Do yourself.
F. Do yourself.

4. Operating a Computer

A. 1.b 2.c 3.b 4.a 5.c 
B. 1. Windows is an operating ………… 
to work together. 2. When the desktop is 
switched on …………. on desktop called 
icons. 3. It shows the applications 
......……..…. switch between them. 4. The 
Start button
C. 1. Click on the Start button. 2. Now 
click on the Shut down button. 3. Turn off  
the UPS. 4. Turn off  the main power 
switch.
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MS PowerPoint, etc. 2. There are some 
……….…… basic input devices. There are 
some ………………. basic output devices. 
3. The mouse is a small ………………. is 
called a 'click'. 4. Operating system is a 
system ……………. and UNIX, etc.

D. 1. Inkjet printer 2. Keyboard

3. Trackball

E. 1. Mouse: The mouse is a small input 
device. It usually has two buttons.

2. Monitor: The monitor is an interface 
between the user and the computer. It is 
also called V.D.U. 3. Printer: The printer is 
a device that gives us output. The output is 
called hard copy. 4. Keyboard: The 
keyboard is used to enter the data into the 
computer. Nowadays, the most commonly 
used keyboard is QWERTY keyboard.   

3. MS Windows 7

A. 1. b 2. a 3. c 4. b 5. c 6. b 7. a

B. 1. F 2. T 3. F 4. T 5. T 6. F

C. 1. The computer takes …………… is 
called booting. 2. It is the long horizontal 
…………….System Tray. 3. To open the 
start menu …………………. settings of  
the computer. 4. Press and hold ………… 
is called dragging. 5. Follow the given 
steps …………… Shut down option.

D. Do yourself.

E. 1. DESKTOP 2. FOLDER

3. DRAGGING 4. START 5. BUTTON

4. Working on MS Paint

A. 1. a 2. b 3. c 4. b 5. a 6. b

B. 1. graphics 2. create, edit, print

3. selection 4. irregular 5. vertically, 
horizontally

C. 1. Microsoft Paint is a …………… on 
the Paint option. 2. The free-form 
selection tool. 3. The redo command 
………………… last actions. Ctrl+Y. 

4. Using the Rotate command …………… 
Flip horizontal. 5. To open an existing 
……………… press Ctrl+O.

D. Do yourself.

E. 1. MICROSOFT 2. ROTATE

3. RESIZE 4. RECTANGLE 5. PAINT 
6. BUTTON

…………. from the Tool Box. 3. The Text 
tool ………….... of  our drawing. 
4. Airbrush tool 5. Do yourself.
F. 1. Pencil tool 2. To fill colour in the 
selected area. 3. Text tool 4. To draw curve 
and wavy lines in our drawing.
G. 1. LINE 2. ERASER 
3. RECTANGLE 4. ELLIPSE 5. TEXT 
6. MAGNIFIER

8. Working in WordPad

A. 1. a 2. c 3. a 4. c 5. a 6. a 

B. 1. We can write questions ………….... 
using the WordPad program. 2. Title Bar, 
Ribbon, WordPad button, Work area, 
Cursor and Zoom in and Zoom out. 3. The 
keyboard. 4. Ribbon. 5. Yes. When you are 
working ……………. not lose your work.

C. Click on the WordPad button ………. 
and click on Save.

D. Click on the Start button ………….. 
click on WordPad.

E. 1. L 2. J 3. J 4. L 5. L

F. Do yourself.

G. Do yourself.

TECH RAY-3 

1. Computer—An Electronic Machine

A  1. b 2. a 3. c 4. b 5. c

B. 1. easier, faster 2. speed 3. result

4. workstation

C. 1. Computer is an electronic ………… 
easier and faster. Characteristics of  a 
Computer ……………. giving the results. 
2. A computer works ………………… is 
called output. 3. Size, cost and speed.

4. Automate the various tasks …………… 
latest computer technology.

D. 1. OUTPUT 2. DATA 3. LAPTOP

4. INPUT 5. SPEED 6. MACHINE

E. 1. Airport 2. Railway Station 3. Bank 
4. Hospital

2. Parts of a Computer

A. 1. b 2. a 3. c 4. b 5. a 6. c

B. Input devices: keyboard, mouse, 
scanner, joystick, lightpen. Output 
devices: monitor, printer, plotter

C. 1. The set of  instructions …………… 
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browser 4. HTTP protocol 5. Google
D. 1. The Internet links ……… resources 
and services. 2. Using the Internet 
………… news, sports, etc. 3. To get an 
Internet ….…………… Internet Service 
Provider (ISP). 4. Internet Service 
Provider …………...… as they should. 
5. Using E-mail ………………… bottom 
of  the screen.
E. Do yourself.

TECH RAY-4 

1. Computer—Then and Now

A. 1. c 2. a 3. b 4. c 5. b
B. 1. (1940 to 1956) The technology in 
the first generation was based on vacuum 
tubes and magnetic drums. 2. (1956 to 
1963) The technology in the second 
generation was based on transistors.
3. (1964 to 1971) The technology in the 
third generation was based on Integrated 
Circuits (ICs). 4. (1971 – present) The 
technology in the fourth generation is 
based on microprocessor. 5. (present and 
beyond) The technology in the fifth 
generation will be based on Artificial 
Intelligence (AI).
C. 1. b 2. d 3. e 4. a 5. c
D. 1. Abacus was the first …….... across 
the wires. 2. Electronic Numerical 
Integrator And Calculator 3. Charles 
Babbage 4.Five 5. The ICs are made 
……….... called semiconductors.
E. 1. Analytical Engine 2. Abacus
3. Pascaline 4. Tabulating Machine
5. Laptop 6. Vacuum tubes
F. 1. VACUUM 2. MACHINE
3. ABACUS 4. TRANSISTORS
5. COMPUTER

2. More About Computer

A. 1. b 2. c 3. a 4. b 5. a 6. a
B. 1. F 2. T 3. F 4. T 5. T
C. Input Device- Keyboard, Barcode 
Reader, Graphic tablet, Webcam, Scanner 
Output Device- Monitor, Printer, Speaker
D. 1. It is the principle on which 
computer works. 2. All the parts ….........  
are called hardware. 3. A biometric sensor 
……………. behavioural traits. 4. Dot 

5. MS Word 2010

A. 1. c 2. b 3. a 4. c 5. b 6. b
B. 1. title bar 2. display, down
3. commands 4. Proofing 5. Format 
Painter
C. 1. F 2. T 3. F 4. T 5. T 
D. 1. Microsoft Word is ……………… as 
MS Word. 2. Quick Access Toolbar 
…….……… above the File tab. 3. The 
panel located ……………… Commands. 
4. The Clipboard group ……………. text 
in the document. 5. This feature allows 
……………… in our document.
E. Do yourself.
F. Do yourself.

6. MS Windows LOGO

A. 1. b 2. a 3. a 4. a 5. b 6. c
B. 1. Logic, Graphic 2. the commander 
window 3. home 4. primitives 5. two
C. 1. b 2. d 3. e 4. a 5. c
D. 1. LOGO is one of  ……………… 
Graphic Oriented. 2. Starting LOGO 
………… Microsoft Windows LOGO. 
3. At the centre ..............…… called 
turtle. 4. FORWARD …….....……… by 
any number. 5. To multiply two numbers 
………………. 50 on the screen.
E. Do yourself.
F. 1. BACK 2. CLEAN 3. PRINT
4. RIGHT 5. BYE

7. Caring of Computer

A. 1. b 2. a 3. c 4. b 5. a 
B. 1. time, money 2. clean 3. cable
4. monitor 5. pirated
C. 1. A computer can ………… browsing 
the Internet. 2. Make sure that …………. 
keyboard gently. 3. Make sure that 
………………… high temperature. 4. Do 
shut down …………… computer through 
Internet.
D. Do yourself.
E. Do yourself. 

8. Know About Internet

A. 1. c 2. a 3. b 4. c 5. c
B. 1. resources, services 2. TCP/IP
3. modem 4. web browser 5. HTTP
C. 1. The Internet 2. A modem 3. A web 
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document. 4. While working in a word 
…………...... using the Replace feature. 5. 
The spelling ............... misskelled word. 
The grammatical ............... green lines. 6. 
The spelling ....................... red lines. The 
grammatical .............. green lines.
E. 1. Cut 2. Paste 3. Copy 4. Spelling and 
Grammar 5. Open 6. Save 7. Change 
Styles 8. MS Word
F. Do yourself.

5. MS Word 2010 – Formatting

A. 1. c 2. b 3. a 4. b 5. c 6. b
B. 1. Formatting 2. Font Color 3. save
4. Picture, Illustrations 5. Print settings, 
Preview 6. File 
C. 1. In this topic …………… Change 
Case commands. 2. Align Left, Align 
Right, Center and Justify. 3. Format 
Painter allows us to copy the formatting of  
already formatted text to some another 
part of  the document. 4. To insert a Clip 
Art ……………… on the selected image. 
5. To print the page …………… Click on 
Print button.
D. 1. c 2. d 3. e 4. f  5. a 6. b 
E. 1. FONT 2. COLOR 3. PICTURE
4. JUSTIFY 5. PARAGRAPH 6. PRINT

6. MS PowerPoint 2010

A. 1. b 2. c 3. a 4. b 5. c 6. a 7. b 
B. 1. slides 2. Slide Sorter 3. File 
4. Reading 5. placeholders, text boxes 
6. Notes
C. 1. MS PowerPoint 2010 2. Title bar 
3. File Tab 4. normal View 5. Delete
D. 1. MS PowerPoint 2010 is a 
presentation ...………… and many more. 
2. To create a new ................……… blank 
presentation opens. 3. It contains the 
slides ........………… the slides from here. 
4. Normal, Slide Sorter, Notes Page and 
Reading View. 5. To insert an image 
……………. image is inserted.
E. Do yourself. F. Do yourself.

7. LOGO Procedures

A. 1. b 2. c 3. c 4. a 5. c 
B. 1. title, body, end 2. LOGO 3. cannot 
4. first 5. END

matrix printer, Inkjet printer and Laser 
printer. 5. There are three main 
components …….....……… Read Only 
Memory (ROM). 6. System software- 
Windows XP and Windows 7 Application 
software- MS Word and MS Excel
E. 1. Joystick 2. Scanner 3. Webcam
4. Graphic tablet 5. Biometric sensor
6. Microphone
F. 1. WEBCAM 2. MOUSE
3. SCANNER 4. PRINTER
5. MICROPHONE
G. 1. c 2. d 3. a 4. e 5. b 

3. More on Windows 7

A. 1. b 2. a 3. c 4. b 5. a 6. c
B. 1. resize 2. taskbar 3. Filp 4. Start 
menu 5. Screen saver
C. Program- Games, Accessories, 
Maintenance, Microsoft Office; Program 
Group- MS Word, MS Excel, Notepad, 
Solitaire. 
D. 1. It is an operating system produced 
by Microsoft for use on personal 
computers. 2. Microsoft has simplified the 
working …………… USB devices faster. 
3. The feature that allows us …....... over 
the taskbar icons. 4. We can search and 
access …………… using the Start menu. 
5. To change the wallpaper ……………... 
to save the settings.
E. 1. Notepad 2. Calculator 3. Paint
4. Flip 3D 5. Windows 7
F. 1. FLIP 2. RESIZE 3. PEEK
4. WALLPAPER 5. SHAKE

4. MS Word 2010 – Editing

A. 1. b 2. b 3. b 4. b 5. c
B. 1. processing 2. New 3. Backspace
4. duplicate 5. Cut 6. move, copy
C. 1. d 2. f  3. e 4. a 5. c 6. b
D. 1. To start MS Word 2010 …………... 
Microsoft Word 2010. 2. The basic tasks 
include ……………. drag and drop text.
3. Cut is used to remove the selected text 
from its place. Copy is used to create a 
duplicate copy of  selected text without 
changing its original form. Paste is used to 
place the copied or removed text at the 
desired location in the same or other 
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D. 1. The period of  computer ………... in 
1951. 2. Use of  vacuum ….... of  electricity. 
3. IBM-1401 and IBM-700 4. The period 
of  computer ………… Central Processing 
Unit (CPU). 5. In Third Generation.
E. 1. Vacuum tubes 2. Transistors
3. Integrated Circuits 4. Microprocessors 
5. Artificial Intelligence

3. Data Storage Media

A. 1. c 2. a 3. b 4. c 5. a 6. b 
B. 1. bit 2. single character
3. motherboard 4. daughterboard 5. read 
6. capacity
C. 1. e 2. c 3. f  4. a 5. d 6. b
D. 1. These binary digits ……....... binary 
data. 2. In short …………1 Byte = 8 bits.  
3. The motherboard …………… attached 
to the motherboard. 4. Sometimes, the 
primary memory ............…… Secondary 
Memory. 5. Pen drive is a small ………… 
makes it superior. 6. a. The full form of  
RAM ……… temporary memory. b. Each 
motherboard …………… called silicon. 
c. The full form of  DVD …………………. 
sides of  the DVD.
E. 1. CD 2. RAM 3. Hard disk
F. Do yourself.

4. Windows Desktop

A. 1. b 2. a 3. b 4. c 5. a 6. b 
B. 1. operating system 2. bootstrap loader 
3. network browser 4. Recycle Bin 5. jump-
arrow
C. 1. T 2. F 3. F 4. T 5. F
D. 1. A bootstrap loader ………...... hard 
disk. 2. When we double-click …………… 
USB drive, etc. 3. When we delete ……… 
their original location. 4. To create a 
shortcut …………… click on Finish.
E. Do yourself. F. Do yourself.

5. MS Word 2010 – Paragraph 
Formatting

A. 1. b 2. c 3. a 4. c 5. b 
B. 1. easier 2. attributes 3. small arrow
4. paragraph 5. Indentation

C. 1. Formatting means changing ……… 

neat to look at. 2. To apply the paragraph 

formatting …………….. Page Layout tab 

C. 1. F 2. T 3. T 4. F 5. T 6. F
D. 1. Procedure is a set of  …………… a 
specific task. 2. Speed and Reusability.
3. Valid Procedure names are …………... 
#OKEY. 4. Once the procedure is defined 
……............ Procedure and save it. 5. 
Editing a Procedure .............. and save it. 
Saving a Procedure ................ on save.
E. 1. PROCEDURE 2. TITLE 
3. COMMANDS 4. ERASE 
5. REUSABILITY 6. BODY
F. Do yourself.

8. Multimedia

A. 1. b 2. a 3. c 4. a
B. 1. digitally 2. interactive, CD-ROMs 
3. audio, video 4. games 5. media
C. 1. F 2. T 3. F 4. T 5. T
D. 1. Multimedia is a means …………… 
news reaches us. 2. Graphics, sounds, text 
and animations. 3. Input devices, output 
devices, storage devices, communication 
network, communication devices, 
computer system and software. 4. Click on 
the Start button ……………. you want to 
play. 5. Education and Business.
E. Do yourself.
F. Do yourself.

TECH RAY-5 

1. The Multifaceted Computers

A. 1. b 2. a 3. b 4. c 5. a
B. 1. principle 2. computer 3. Processing 
4. cannot 5. versatile 6. satellites 7. library 
cards
C. 1. A computer is an …………… O 
stands for Output. 2. There are many 
……………… Joystick, Speakers.
3. Computers are widely used …….......... 
trains and flights. 4. To send and receive 
important information. 5. Computers are 
used ……………… the account balance.
D. 1. ATM 2. Joystick E. Do yourself.

2. Computer Generations

A. 1. b 2. a 3. c 4. b 5. c
B. 1. UNIVAC, ENIAC 2. transistors
3. Charles Babbage 4. third 5. Integrated 
Circuits 6. Artificial Intelligence
C. 1. b 2. e 3. c 4. a 5. d
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B. 1. Photo Album 2. Album Layout

3. SmartArt 4. MS PowerPoint 5. graphic 
6. MP3

C. 1. F 2. F 3. F 4. T 5. T 

D. 1. A photo-album is a ......…………… 
PowerPoint presentation. 2. We can create 
a photo album ………………. show will 
be created. 3. We can insert a SmartArt 
…………… the SmartArt graphic. 4. We 
use shapes as a …………. appeal to a slide.

5. From the Insert tab ………............ into 
the slide. 6. Yes, From the Insert tab 
……………….. into the slide.

E. Do yourself.

F. 1. G 2. G 3. T 4. T 5. G 6. T 7. T 8. G 
9. G 10. T

9. Network and Internet

A. 1. b 2. a 3. b 4. c 5. a 6. b
B. 1. World Wide Web 2. website
3. hyperlinks 4. fastest, reliable 5. received
C. 1. T 2. F 3. T 4. T 5. F
D. 1. The Internet is a network ………… 
and send e-mails. 2. Information Transfer 
……………… to any other person. 3. Web 
browser is a software ……………… used 
web browsers. 4. Each website has a 
…………………… pages of  the website. 
5. All the mails ………………… text in the 
mail. 6. E-Mail is the short form 
……………… in touch with people.
E. 1. PRINT 2. REFRESH 3. BACK
4. FORWARD 5. HOME
F. 3. 1. 5. 4. 2.

10. Algorithms and Flowcharts

A. 1. b 2. c 3. b 4. a 5. b 
B. 1. processing box 2. graphical
3. flowchart 4. Connector 5. independent
C. 1. b 2. d 3. e 4. a 5. c
D. 1. An algorithm is a set ……………... 
understand it better. 2. We write a program 
……………… flowchart into program. 
3. Input .....………………… and the time. 
4. They are easy …………… to solve a 
problem. 5. Start or Stop box …………… 
process on data. 6. When the program 
………….... cannot be typed.
E. Do yourself.
F. Do yourself.

the Ribbon. 3. Alignment means adjusting 

………………. shortcut is Ctrl + J. 4. To 

print a word document ……………. your 

preferences.

D. 1. The given paragraph ……………. 

Ctrl+E. 2. Apart from above ………… 

accordingly. 3. Indentation means to set 

………………. dialog box.

E. Do yourself. F. Do yourself.

6. MS Word 2010 – Word Art and 
Graphics

A. 1. a 2. b 3. a 4. b 5. c 6. b

B. 1. WordArt, stretch 2. Insert

3. WordArt Styles 4. add, modify 5. Home 

6. Arrange, Wrap Text.

C. 1. T 2 . F 3. F 4. T 5. F 

D. 1. e 2. d 3. a 4. b 5. c

E. 1. WordArt is a text-styling …………. 

shape  of  the text. 2. To insert WordArt 

……………… Click on OK. 3. To format a 

text ……………. style to the text. 4. A 

Quick Style applies …………… text 

effects. 5. To wrap text ……………. for 

each setting. 6. Yes. To insert an audio 

…………. Insert button.

E. Do yourself.
F. 3. 1. 6. 5. 4. 2.

7. More on MS PowerPoint 2010

A. 1. b 2. c 3. a 4. c 5. a 6. b 

B. 1. Insert 2. ideas, information 3. edit 

4. Clip Art, WordArt 5. format 6. Images

C. 1. a 2. b 3. c 4. d 5. e

D. 1. To start the MS PowerPoint 
………… window is opened. 2. MS 
PowerPoint is one ……………... are 
called slides. 3. To insert a new slide 
………………. slide is inserted. 4. Go to 
the Insert tab ……………. appears in the 
slide. 5. Yes. In the Format Background 
………………. the selected texture. 

6. Select the slide ………… Click on OK.

E. Do yourself.

F. 3. 6. 4. 1. 2. 7. 5.

8. MS PowerPoint 2010 – Graphics

A. 1. b 2. a 3. c 4. b 5. c 6. a
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D. 1. Computer is the gateway ………. to 

your PC. 2. This icon provides temporary 

…………… you delete. 3. The four edges 

………… of  the window. 4. A slider works 

like ……… the same value. 5. Just below 

the top ……………. moving the window. 

E. 1. The row of  the words ……………. 

Window and Help. 2. Pressing the right 

mouse …………… to the Taskbar. 

3. Check boxes are small boxes ………… 

Selections do not apply. 4. To change the 

active window ………… to be foreground. 

5. Option buttons are also ………… next 

to the button.

Formative Assessment

1. Borders, Title Bar, System Menu Icon, 

Close Button, Menu Bar

2. Grayed (Dimmed) Command Name, 

Ellipses, Check Mark, Triangle, A Key 

Combination and Short-cut Menus 

3. Text boxes, Check boxes, Option 

buttons, Command buttons, Drop-Down 

list boxes, Sliders, Spinners

Hots: 1. A toggle 2. The insertion point 

3. Click the Preview pane button

3. About Windows

A. 1. a 2. b 3. d 4. a 5. a 6. c 7. a
B. 1. T 2. T 3. T 4. T 5. F 6. T 7. T
C. 1. Operating System 2. Graphical 
User Interface 3. RUN 4. Windows
5. Button configuration 6. Regional setting  
7. On-Screen Keyboard
D. 1. An Operating System ………….. 
and applications run. 2. Search Option is a 
……………… and all folders. 3. The Run 
command ……….......... Windows will 
then open. 4. Wildcards …………………. 
character or space.
E. 1. Some of  the advantages of  
Windows ................... at the same time. 
2. The Run command …………… 
Windows will then open. 3. Search option 
is a ..................……. character or space. 
4. Wildcards …………………. character 
or space. 5. The Control Panel is ………… 
parental control, etc. 6. This icon has been 
used ………………. Click on OK.

TECH RAY

1. Start with Computer

A. 1. b 2. c 3. a 4. d 5. c 6. a 

B. 1. T 2. T 3. T 4. F 5. F

C. 1. Napier 2. transistors 3. palmtop

4. hardware 5. processor 6. nibble

D. 1. A computer is an electronic device 

....…………… to achieve desired results. 

2. On binary-coded language. 3.An 

internal clock 4. An input device is any 

hardware ...…………......... the computer. 

5. A binary unit is logical …………….... 

electric circuit.

E. 1. First generation: ENIAC, EDVAC 

and UNIVAC. Second generation: PDP-8, 

IBM 1401 and IBM 7090. Third 

generation: NCR 395 and B6500. Fourth 

generation: Apple II, Altair 8800 and 

CRAY-1. 2. Secondary memory is also 

known ………………… process data 

much more quickly. 3. MU is that part of  

the computer ………………. is called a 

nibble.  4. It is Random Access Memory 

……………...... stores data permanently. 

5. A compiler is a program …………… as 

a translator. 6. Utility software is a 

computer ………………… Application 

Launchers and Virus Scanners.

F. 1. Central Processing Unit 

2. Arithmetic Logic Unit 3. Liquid Crystal 

Display 4. Very-Large-Scale Integration 

5. Ultra-Large-Scale Integration

G. 1. COMPUTE 2. DUST 3. NAPIER 

B O N E S  4 .  M A G N E T I C  I N K  

CHARACTER RECOGNITION

5. AUXILIARY MEMORY 6. BYTE

2. Basic Elements of Opening Screen of 
Windows

A. 1. a 2. b 3. c 4. d 5. a 6. b 7. c 8. d 

B. 1. Recycle Bin 2. window 3. Title Bar 

4. Close button 5. Scroll bars 6. available 

7. diamond 8. internet

C. 1. T 2. T 3. T 4. F 5. F 6. T 7. T 8. T 9. T 

10. T 11. F 12. T

- 6
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window. 5. On the Themes …………… 
their corresponding menus. 
F. Do yourself
Hots: Do yourself.

7. More About MS Excel

A. 1. b 2. c 3. a 4. d 5. a 6. b 7. a 
B. 1. MS Excel 2. Formatting 3. modified 
4. gridlines 5. grow font 6. standard 7. cells
C. 1. T 2. F 3. F 4. T 5. T 6. T 7. F
D. 1. It adds up all the values in a range of  
cells. 2. It calculates the average of  the cell 
values. 3. It counts the cell values.
4.To remove borders in a worksheet.
E. 1. Excel is a spreadsheet …………… 
professional looking chart. 2. Numbers 
entered in ……………… in the selected 
format. 3. You can add borders ………... 
Page Layout tab. 4.To Change the Font 
……………… in the Menu Bar).
5. Sometimes errors ................... invalid 
range operator. 
F. Do yourself.
Hots: Do yourself.

8. Introduction to QBASIC

A. 1. d 2. a 3. b 4. a 5. c 6. a 7. d 
B. 1. .BAS 2. Save 3. GW BASIC
4. Status Bar 5. Menu 6. Program Name 
7. Exit
C. 1. F 2. T 3. F 4. T 5. F 6. T 7. T
D. 1. The bar presents ……………… file 
name. 2. The Menu bar ………….... 
Options and Help. 3. To Exit from 
……………. the file. 4. It is the actual 
workspace .............. the input. 5. It helps 
to scroll ………...... not visible.
E. 1. QBASIC is a programming ………. 
for GW BASIC. 2. Title Bar, Menu Bar, 
Prog ram Area,  Prog ram Name,  
Horizontal Scrollbar, Vertical Scrollbar, 
Status Bar, Immediate Mode Area. 3. The 
first command …………..... in a program. 
4. To write a simple …………....... screen 
occurs. 5. After writing a program 
……………. the File menu.
F. 1. Title Bar 2. Menu Bar 3. Program 
Area 4. Program Name 5. Horizontal 
Scrollbar 6. Vertical Scrollbar 7. Status Bar 
8. Immediate Mode Area

F. 1. 5. 3. 2. 4.
G. GOOEY, WILDCARDS, RUN, 
SCREEN, DESKTOP 
Hots: Do yourself. 

4. MS Word Advanced Features

A. 1. a 2. b 3. c 4. d 5. c 6. a 7. d 8. b
B. 1. MS Word 2. top 3. Ctrl+Alt+F
4. Drop Cap 5. preset 6. non-printing
7. Format Painter 8. dictionary 
C. 1. T 2. T 3. F 4. T 5. T 6. T 7. T
D. 1. Ctrl+Alt+F 2. Ctrl+Alt+D 
3. Ctrl+Shift+L 4. Shift+F7
E. Do yourself.
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

5. MS Word using Mail Merge Features

A. 1. a 2. b 3. b 4. a 5. d 6. b 7. c 8. a

B. 1. T 2. F 3. T 4. T 5. T 6. F

C. 1. Mail Merge ……….......... by Word 
2010. 2. Five 3.Letters …….......... 
Directory 4. It specifies how do you want 
to set up your letters.

D. 1. Mail Merge ……......... by Word 
2010. 2. Mail Merge group ………….. 
Directory. 3. The document consisting of  
a common data the needs to be created in 
multiple numbers. 4. Mail Merge 5. Mail 
Merge group ............. and Directory.

E. Do yourself.

Hots: Do yourself.

6. Advanced PowerPoint

A. 1. a 2. c 3. b 4. d 5. c
B. 1. presentation 2. thumbnail 
3. PowerPoint  4. arrow 5. easily 6. subtitle
C. 1. T 2. T 3. F  4. T 5. T  
D. 1. A PowerPoint template is ……....... 
are based. 2. A template already ……….. 
other design elements. 3. Click the File tab 
………….... in a new window. 4. The Slide 
and Outline ……………… text or slides. 
E. 1. A PowerPoint template …………... 
as the originating template. 2. When a new 
presentation …………………. with 
Presentation 1. 3. Click the File tab 
......…………… desired presentation text. 
4. Click the File tab …………..... in a new 
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services. 5. Spams
E. Do yourself.
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

TECH RAY-7

1. Network and Communication

A. 1. a 2. b 3. c 4. d 5. d  6. c 7. b 8. a 9. a 
10. c
B. 1. share data 2. network 3. Hub
4. wireless transmission 5. primitive
6. homes 7. File server 8. Coaxial cable 
9. Network Adaptor 10.data
C. 1. F 2. T 3. T 4. T 5. T 6. F 7. T 8. F 9. F 
10. F
D. 1. A computer network enables 
………. or infrared light beams. 2. Speed, 
Cost Effective, Security Concerns, 
Centralised Software Management and 
Resource Sharing. 3. In LAN two or more 
……… as compared to WAN. 4. Network 
Interface card ………… network and the 
computers. 5. There is no need ………. 
their shared resources. 6. Coaxial cable is 
the kind ……………. small networks, 
cable TV, etc. 7.Infrared is one of  the most 
………………. using infrared rays.
E. 1. Networking of  computers ………… 
services to all twelve users. 2. The 
following are the disadvantages ………… 
throughout a computer network. 3. There 
are many components …………… in a 
network using these channels. 4. The 
physical arrangement ………………. as a 
topology. Example: Bus topology 5.Bus 
topology refers to a single ……………… 
either clockwise or anti-clockwise. 6. Peer-
to-peer architecture is a commonly 
..……………. as a peer-to-peer network. 
7. A server is just like ………………. 
functioning of  other computers. 8. In Ring 
topology ……………………. either 
clockwise or anti-clockwise.
F. 1. Wide Area Network 
2. Metropolitan Area Network
3. Transmission Control Protocol
4. Hyper Text Transfer Protocol
5. Simple Mail Transfer Protocol 6.File 
Transfer Protocol 7. Network Interface 

Hots: Do yourself.

9. QBASIC Statements

A. 1. a 2. d 3. b 4. d 5. d 6. d 7. c 8. b
B. 1. rules 2. special 3. variable 
4. numeric 5. execution 6. String
7. Semicolon 8. INPUT
C. 1. A set of  characters …………… [,], 
etc. 2. Constants …………....... Numeric 
Constant. 3. Print Statement …………… 
on the monitor. 4. It is similar ………..... 
PRINT command. 5. The  INPUT 
statement …………......... Variable name.
D. 1.Print statement ……………… will 
display 6. 2. A program is written ………. 
Precision variables. 3. The first key word 
…………. on that line. 4. The INPUT 
statement …………......... Name $. 
5. LET statement …………. value of  10.
E. 1. c 2. e 3. b 4. f  5. a 6. d 
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

10. QBASIC Programming Statements

A. 1. a 2. b 3. c 4. b 5. a 6. b 7. c

B. 1. QBASIC 2. string 3. blank

4. Program 5. variable 6. symbols 

7. Numeric

C. 1. T 2. T 3. T 4. T 5. F 6. F 7. F

D. 1. To print any document 2. By using 
various .................... called programming 
3. Arithmetic Operators are used ............. 
C = a-b 4. Do yourself.

E. Do yourself.

F. Do yourself.

G. Do yourself.
Hots: Do yourself.

11. Introduction to Email

A. 1. b 2. b 3. c 4. d 5. d 6. d 7. c  8. b
B. 1. Internet 2. Uniform Resource 
Locator 3. lower case , upper case 4. Email 
5. Sent box 6. outgoing 7. Viewing 
Attachments
C. 1. T 2. T 3. T 4. T 5. T 6. F 7. T
D. 1. Electronic mail ……........ services 
available. 2. Uniform Resource Locator 
3. Domain Name System 4. It is the name 
of  the email server that provides email 
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F. Do yourself.
Hots: 1. Dollar sign ($) 
2. Do yourself.

3. World Wide Web

A. 1. a 2. b 3. c 4. d 5. a 6. b 7. c
B. 1. network 2. HTTP:// 3. servers 
4. TCP 5.information 6.services
7.individual person
C. 1.e 2.d 3.b 4.a 5.c
D. 1.It is the standard protocol ………… 
the Internet. 2. It's a set of  communication 
…………………. over the Internet. 3. E-
C o m m e r c e ,  E d u c a t i o n  a n d  
Entertainment. 4. M-Commerce is about 
the explosion ………………. mobile 
devices.
E. 1.E-Commerce  or  E lec t ronic  
Commerce is online trading …………. 
payment mode and details. 2. The Internet 
relies on a number …………… two places 
on a network. HTTP, FTP, SMTP, etc. 
3.The components of  the Web …………. 
high-speed interconnects. 4. E-Commerce 
or Electronic Commerce is online trading 
……………. and communicate with 
friends. 5. Web hosting is the service 
……………… you want to spend.
F. 1. Internet Service Provider
2. Transmission Control Protocol
3. Simple Mail Transfer Protocol 4. File 
Transfer Protocol 5. Hyper Text Transfer 
Protocol 6. World Wide Web Consortium 
7. Electronic Commerce 8. World Wide 
Web
Hots: Do yourself.

4. QBASIC Programming Statements

A. 1. a 2. c 3. b 4. d 5. a 6. b 7. a
B. 1. iterative 2. Exit 3. DO UNTIL
4. loop 5. iterative 6. false 7. executions 
8. STEP
C. 1. T 2. T 3. F 4. T 5. T 6. F 7. T
D. 1. Sometimes there is a need to repeat 
…………......... is called loop. 2. DO 
UNTIL test condition Statement 1
Statement 2 ...... LOOP 3. DO WHILE 
test condition Statement 1 Statement 2 
........ LOOP 4. Exit command is used to 
………………  FOR or DO. 

Card 8. Internet Protocol 9. Local Area 
Network 10. Wireless Fidelity
Hots: 1. Hub is the central device that 
provides a central connection point for 
nodes on the network. On a star network, 
if  one of  the nodes fail, only that node is 
affected. The other nodes continue to 
operate normally. If  the hub fails, 
however, the entire network is inoperable 
until the hub is required. 2. The full form 
of  CAN is Campus Area Network and it 
is smaller than LAN.

2. MS Excel-Advanced Features

A. 1. d 2. c 3. b 4. a 5. c 6. a 7. d 8. c 9. a 
10. b
B. 1. MS Excel 2. columns 3. null
4. Absolute cell 5. comparison 6. decimal 
7. absolute 8. Cells 9. cell address
10. concatenation
C. 1. T 2. F 3. T 4. T 5. T 6. T 7. F 8. F 
9. F 10. T
D. 1. Excel uses four types of  operators. 
These are- Arithmetic Operator, Text 
Concatenation Operator, Comparison 
Operator and Reference Operator.
2. Roundup ( ) function rounds a number 
up away from 0 (zero). Example: 
ROUNDUP (3.27, 1) EQUAL 3.3
3. ABS ( ) function returns the absolute 
value of  number. 4. SQRT ( ) returns a 
positive square root of  a number. 5. Each 
rectangle in a worksheet is called a cell. 
6. To compare values ............................. 
comparison operators. 
E. 1. In Excel, a cell reference ………..... 
and Mixed Reference. 2. The MS Excel 
software allows you ……………......... 
compiling examination results. 3. The 
ampersand ……….......... A1 and C1 is 
joined. 4. Reference Operators make no 
changes ................................... is made 
to calculate. Example-SUM (A7:A11) 
5. Mathematical functions are used to 
perform ……………….......... rounding 
of  a number. 6. Click on a cell 
………………. arrow keys on your 
keyboard. 7. A mixed cell reference is 
either …………............ you create an 
absolute row.
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be pronounced as …………. To be very 
blocky. 4. There are three types of  lasso 
tools. Lasso Tool, Polygonal Lasso Tool 
and Magnetic Lasso Tool. 5. This gives a 
.jpg extension to the file ……………. Joint 
Photographic Experts Group. 6. There are 
three selection tools ........……………… 
selection with curved lines. 7. The Lasso 
Tool 8. Here are the ..................... Shift 
modifier.
E. 1. There are two types of  images 
.......…………. drawings and complex 
diagrams. 2. It is measured …......……….. 
occupies more computer memory. 
3. There is RGB color ................ setting 
dialog box. 4. There are three selection 
tools .............……........ The Lasso tool. 
5. Photoshop uses the foreground color 
.……………… appears in the lower box. 
6. To create a new file ……………. The 
following parameters. 7. This tool allows 
you to select .....……………. is dragged 
gets selected.
F. Do yourself.
Hots: Do yourself.

7. Introduction to HTML

A. 1. b 2. d 3. a 4. c 5. a 6. c 7. b 8. b 
B. 1. Hyper Text Markup Language
2. .html 3. text 4. Container 5.<HTML> 
6.headings 7.Container 8.First tag
C. 1. T 2. F 3. T 4. T 5. T 6. T 7. F 8. F
D. 1. These tags have ………. an HTML 
element. 2. HTML markup tags are 
usually called HTML tags. 3. WYSIWYG 
stands for …………...… WYSIWYG 
editor. 4. These tags have ……………. 
HTML element. 5. A way of  writing 
layout information within documents. 
E. 1. It is simple scripting language 
……………. simple to understand. 2. The 
content typed along ………………. to 
describe the same thing. 3. Attributes of  a 
tag provide ……………… <IMG align= 
“”left”> 4. HTML markup tags are 
............ the smallest heading. Attributes 
of  a tag ..........…………… is an attribute 
value. 5. WYSIWYG stands for ……….… 
WYSIWYG editor. To work with a text 
editor ………………… of  a text editor.

E. 1. Sometimes there is a need ………. is 
getting satisfied. 2. DO WHILE ..... 
LOOP is yet another ……………. type of  
looping structure. 3. Except for the syntax 
……………… executed at least once.
4. DO WHILE.....LOOP is yet another 
iterative ……………. the condition is true. 
5. Exit command is used to come ………. 
either FOR or DO.
Hots: Do yourself.

5. QBASIC Graphics and Sound

A. 1. d 2. b 3. a 4. c 5. a 6. b 7. c
B. 1. thousands 2. good quality 3. Screen 
4. resolution 5. QBASIC 6. PRESET
7. visible 8. diagonal 
C. 1. F 2. T 3. F 4. F 5. T 6. T 7. T
D. 1. The BEEP command ……..... half  
a second. 2. PAINT command is used 
…….....  specified color. 3. The SOUND 
command produces sound ……………… 
personal computer. 4. The display on a 
computer's screen ……………..... on the 
screen. 5. The Text mode can display only 
text.
E. 1. Because it is not a graphic-oriented 
programming language. 2. LINE 
command is used ........……… (35,30), 4. 
3. This command is used ……………...... 
text in the PRINT statement. The 16 
colors can be used in QBASIC. 4. LINE 
command is used to draw ……………… 
display in graphics mode. 5. PRESET 
command is similar ……………. Row of  
the pixel.
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

6. Photoshop: Basic

A. 1. a 2. b 3. c 4. a 5. c  6. d 7. b 8. a 9. a 
10. d
B. 1. Lasso 2. Brush 3. Stamp 4. Painting 
5. Gradient 6. Text 7. Selection 8. Zoom 
9. grid of  pixels 10. Zoom
C. 1. T 2. T 3. F 4. T 5. T 6. T 7. T 8. F
D. 1. Adobe Photoshop is a professional 
………...... an existing one. 2. Vector 
graphics are not made ...............………. 
Drawings or complex diagrams. 3. It can 
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Hots: Do yourself.

10. Virus and Anti-virus

A. 1. a 2. b 3. c 4. d 5. a 6. b 7. c 8. d
B. 1. corrupt 2. attachments
3. downloads 4. replicate 5. 1999
6. computers 7. worm 8. Anti-virus
9. annual 10. Pop-up
C. 1. T 2. F 3. T 4. F 5. T 6. T 7. T 8. T
D. 1. Vital information under seize. 2. A 
Trojan horse is a …………… download 
software. 3. A rogue security software. 
4. Your computer may be ……………. 
Frequent computer crashes. 5. A worm, A 
Trojan horse, a spyware and rogue security 
software.
E. 1. A computer virus ……………… 
that you might download. 2. One of  the 
intents …………… to get rid of. 3. The 
task of  a virus ……………. some 
economic agenda. 4. Installing an anti-
virus ………………… operating system, 
or files. 5. A worm is computer code 
…………………… performance and 
stability problems. 
F. Virus and Anti-virus¯ A computer 
virus is a small ……………. on the hard 
disk. Installing an anti-virus program 
……..........  operating system, or files.
Worms and Trojan horse¯ A worm is 
computer code …………… and stability 
problems. A Trojan horse is a malicious 
……………… download software.
Spyware and rogue security software¯ 
Spyware can install …………. Intend to 
go to. A rogue security software 
……………..Windows files as infections.
G. Do yourself.
Hots: Do yourself.

11. Browsing Internet

A. 1. a 2. b 3. c 4. d 5. a 6. b 7. c 8. d 
B. 1. Internet 2. applications 3. three
4. communicate 5. interlinked 6. e-mail 
7. username, password 8. word
C. 1. T 2. T 3. T 4. F 5. T 6. T 7. F 8. F 
D. 1. Advance Research Project Agency 
Network. 2. The World Web is based 
……………… and Web browsers. 
3. Researcher Tim Berners-Lee ………… 

F. Do yourself.
G. Do yourself.
Hots: Do yourself.

8. Log On To Flash

A. 1. c 2. a 3. a 4. a 5. a 6. c 7. a 8. d
B. 1. Flash 2. Adobe Flash 3. Property 
Inspector 4. .swf  5. Oval 6. Timeline
7. Tools 8. Flash
C. 1. T 2. T 3. T 4. T 5. T 6. F 7. T 8. F
D. 1. The Stage 2. Timeline Panel
3. PolyStar tool 4. Shift + click selection
5. Ctrl + Enter 6. Straighten
E. 1. Flash is an animation …………… is 
an animation software. 2. The following 
are the components ……………........ that 
appears on the Stage. 3. This is the area 
……….......... events in sequence. 4. The 
Timeline is a fixed ………………. events 
in sequence. 5. Steps to create .................. 
on “.fla”. 6. This tool is used ................. 
draw a rounded rectangle.
 F. Do yourself. 
G. Do yourself.
Hots: Do yourself.

9. Animation in Flash

A. 1. b 2. d 3. a 4. c  5. a 6. b 7. c
B. 1. stop motion 2. drawing 3. creating 
4. Layers 5. frame 6. location 7. Flash
C. 1. F 2. T 3. T 4. T 5. F 6. T 7. T
D. 1. Animation is the process ……….... 
illusion of  movement. 2. Layers are like  
multiple ..………… appears on the stage. 
3. Animation is a series ……………… 
called a Frame. 4. There are three types of  
layers which can be created in Flash. 
Normal Layer, Gide and Guided Layer, 
Mask and Masked Layer. 5. Circular, zig-
zag and curved paths.
E. 1. Animation is the process ………… 
quickly changing images. 2. The Timeline 
organizes and controls ……………… to 
the current frame. 3. Layers are like 
…………. and the playhead. 4. The steps 
to create Motion Tween animation are 
...…………… keyframe at the Frame. 5. In 
Flash, working in ...……. front of  the wall.
F. Do yourself.
G. Do yourself.
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OK button. 6. Some major components of  
MS Access database are ………………… 
written to access the database. 
F. 1. A column within a table …….......... 
known as field. 2. The complete set 
……………...... is called a record. 3. It is a 
collection …………….......… rows and 
columns. 4. They are basically questions 
…………....... of  the database. 5. They 
help you to perform ……………. into a 
single command. 6. Modules are the 
collection ………………... to access the 
database. 7. Forms are the input 
………………… data entry process.
G. 1. components of  a computer system 
2. field 3. record 4. can be shared among 
multiple users or application programs
5. can also be placed on a network and 
multiply users can share and update the 
data contained in the database. 6. at the 
bottom of  Access window 7. add, view 
and edit data of  the tables
Hots: 1. Data and information are 
important components ……........... can 
also modify data.  2. It has built many 
features ……………. contained in the 
database.

2. More on HTML

A. 1. a 2. d 3. b 4. a 5. c 6. a 7. b
B. 1. T 2. F 3. T 4. F 5. F 6. T 7. T 
C. 1. FrontPage 2. HTML 3. Start 
4. definition list 5. Empty 6. lowest
7. COLOR
D. 1. HyperText Markup Language
2. HTML markup tags ………… display 
the text. 3. HTML offers three …………… 
Definitions. 4. .html 5. COLOR Attribute
E. 1. HTML is easy to use …………...... 
user interaction. 2. To create an HTML 
…………......... Save button. 3. HTML 
code ……………..... </html>. 4. In 
HTML, the container …………………. 
the next line. 5. Heading element is a 
HTML …………....... of  the document. 
6. The Font element …………....... face 
and size.
F. 1. HTML is a computer ……………… 
(World Wide Web). 2. HTML markup 
tags ………................ display the text.

and early 1990s. 4. To sent and receive 
……………… the world. 5. Modem is a 
device ...………….... lines and vice versa. 
6. A chat room is an area …………......... 
are chatting about. 
E. 1. The Internet is a massive ………..… 
of  free information sharing. 
2. E–Commerce stand for …………….... 
consumer to cosumer.
3. An Internet connection …………........ 
Internet Service Provider. 4. Type the web 
address ………………. button to go 
ahead. 5. E-mail is the fastest way 
………………. www.rediffmail.com.
6. Internet is chiefly …………….... 
www.bing.com.
F. 1. PRINT 2. REFRESH 3. BACK
4. FORWARD 5. HYPERLINK
6. HOME
G. Do yourself.
Hots: Do yourself.

TECH RAY-8

1. MS Access

A. 1. d 2. a 3. a 4. a 5. d 6. c 7. b
B. 1. T 2. F 3. T 4. F 5. F 6. T
C. 1. Data 2. column 3. DBMS 4. non-
programmers 5. Open 6.bottom
D. 1. A database is an organised ……… 
and records. 2. A database management 
system ………….....…… into a database. 
3. They store information ….......………. 
and columns (fields). These present data 
..…………… printed format. 4. Microsoft 
Office Access 2010 is a pseudo-relational 
..…………… software development tools. 
5. Steps to start MS Access are 
…………………. with Microsoft Office 
Access.
E. 1.The structure of  a database ……….. 
is stored in tables. 2. DBMS is useful in 
several aspects ………………. hardware 
and software failures. 3. To create a new 
database …………............. database on 
the title bar. 4. The parts of  MS Access 
Database Interface Window are Title Bar, 
Access Ribbon, Status Bar, Scroll Bar, 
Navigation Pane and Access work area. 
5. Click on the Microsoft Office button 
……………… in Save As box and press 

14



common properties. 5. Integrated 
Development Environment
E. 1. A programming language ……...... 
a lgor i thms precise ly.  2 .  C is  a  
programming …….........… trying to 
solve. 3. To save a program …………….. 
have a .cpp extension. 4. We use 
#include<iostream> ……......…... output 
respectively. 
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

5. Communication on the Net

A. 1. c 2. c 3. d 4. a 5. a 6. b
B. 1. Browsing 2. free, paid 3. E-
marketing 4. communication 5. group 
communication 6. Acronyms 
7. newsgroup 8. popular
C. 1. We can also find ……………… 
www.worldpages.com 2. Open the website 
……………… will be open. 3. You can 
send greeting .......... www.hallmark.com
D. 1. Users sometimes ………….......... a 
correction. 2. Instant messaging 
…............… nature of  e-mails. 3. (i) 
Blackberry Messenger and Whatsapp 
( i i ) w w w. 1 2 3 g r e e t i n g s . c o m  a n d  
www.hallmark.com 4. Communication is 
the most ............... supporting the 
Internet. 5. Internet chat
E. 1. An acronym is an …………. In My 
Opinion. 2.Many educational ………… 
use of  Internet. 3. Video Conferencing is a 
method …………… video conferencing. 
4. Newsgroups is a ‘worldwide’ …………. 
around the world. 5. Each culture operates 
……………........ Internet Users. 6. The 
Internet is a good ……….............. using 
Google Talk. 7. Symbol that you type 
………….............. in our messages.
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

6. Visual Basic

A. 1. d 2. a 3. a 4. c 5. d 6. b 7. d 8. b
B. 1. BASIC 2. May, 1991 3. Title Bar
4. code window 5. execute, visual basic 
program 6. appearance, behaviour

3. It is also known …………….......... in a 
proper sequence. 4. It is also known 
……………...... with bullets. 5. The Bold 
element ……………..... displayed in bold. 
6. The Italic element ……………... italic 
typeface. 7. The Underline element 
………….......... underlined.
G. 1. HyperText Markup Language 2. the 
way that the web browser will display the 
text. 3. for three kinds of  ordered lists.
4. numerous terms and descriptions. 5. the 
line and displays the text from the next 
line. 6. the value of  the text size to 6 
</FONT> 7.<BODY>
Hots: Do yourself.

3. Special Effects in HTML

A. 1. b 2. a 3. d 4. b 5. b 6. a 7. b
B. 1. F 2. T 3. F 4. T 5. F 6. T 7. T
C. 1. <TABLE> 2. Border 3. CELL 
SPACING 4. empty 5.image
6. information 7. Frames
D. 1. <TABLE> tag 2. By simply adding 
the BORDERCOLOR attribute. 3. CELL 
SPACING 4. Checkboxes are used 
</html> 5. An HTML form ............... 
action attribute, etc.
E. 1. You may want to ...…… tables, etc. 
2. To create a table .....…. </html>. 3. The 
Table tag ….................. cells or rows. 4. A 
“hyperlink” is most ........………. <html>. 
5. In HTML, images ......………</html>. 
6. This example demonstrates ........…….. 
</html>. 7. The <frameset> tag defines 
..........………  </html>.
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

4. Programming with C++

A. 1. a 2. b 3. c 4. d 5. a 6. b 7. a 8. d
B. 1. T 2. T 3. T 4. F 5. T 6. F 7. T 8. T
C. 1. specified 2. ISO 3. flexible 4. Turbo 
C++ 5. Editor 6. program code 7. Editor 
window 8. Scroll bars
D. 1. A program is a set of  instructions 
given to the computer. 2. A variable is a 
way …………........... of  a table. 3. C++ 
was introduced ….....…………. 1983-85. 
4. A class consists of  objects that share 
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C. 1. T 2. F 3. F 4. T 5. T 6. F
D. 1. Design Mode, Run Mode and Break 
Mode. 2. project 1 3. A form contains …… 
buttons, etc. 4. Form Window
E. 1. Visual Basic is a ………...... dialog 
boxes, etc. 2. In computer programming 
………………. event handling. 3. An 
integrated development ……………… 
single platform. 4. Click on Start Menu 
…………… End option.
F. Do yourself.
Hots: Do yourself.

7. More on Visual Basic

A. 1. a 2. b 3. a 4. c 5. d 6. b
B. 1.  prog ramming 2 .  memor y,  
temporarily 3. Relational 4. The 
statements 5. counter, counting
C. 1. T 2. F 3. F 4. T 5. T
D. 1. Rapid Application Development
2. It is used to specify the color of  the 
shape. 3. Logical operators ……………. 
true or not. 4. Variables refer ……………. 
to be stored. 5. It is used for making 
…………....... are executed.
E. 1. Image control is used ……………. 
horizontal lines, etc. 2. Form has more 
objects ……………. from the list. 3. Image 
control is used ……….......... in a form. 
4. Operators are the special ……………… 
false as result. 5. It is used to repeatedly 
………………. print button.
F. Do yourself.
Hots: Do yourself.

8. Animation in Flash

A. 1. b 2. a 3. c 4. a 5. d 6. b
B. 1. web 2. unique 3. movie 4. Timeline 
5. visible 6. Selection 7. Lasso 8. smooth
C. 1. F 2. T 3. F 4. F 5. T 6. F
D. 1. F6 2. Ctrl+R 3. F8 4. Ctrl+G
5. Ctrl+B 6. Ctrl+R
E. Do yourself
F. Do yourself.
G. Do yourself.
Hots: Do yourself.

9. Computer Threats

A. 1. a 2. b 3. c 4. d 5. a 6. b 7. d 8. d
B. 1. Hardware 2. access, deleted
3. appearing 4. Macro virus 5. Hacking 
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6. Phishing 7. Biometric 8.firewall, 
security
C. 1. T 2. F 3. T 4. T 5. F 6. T
D. 1. (i) A Trojan horse …………. their 
computers. (ii) A computer worm 
……........ its speed. 2. People commonly 
………………... on a computer. 3. This 
type of  virus ………………… antivirus 
software. 4. You are unable to access 
…………… PC is stoned’.
E. 1. Antivirus software is a software 
used to prevent, detect and remove 
malware. Eg: Quick Heal Total Security 
2. A network is formed ……………. pen 
drives. 3. Now we know ……………… 
authentication methods. 4. Phishing is a 
very specific ………….... password or 
PIN. 5. A firewall is a security …………… 
security criteria. 6. People commonly 
……............. on a computer. This virus 
technique …………… to that computer.
F. Do yourself.
Hots: Do yourself.

10. Introduction of Oracle

A. 1. d 2. a 3. c 4. b 5. d 6. a 7. c 8. b 9. a 
10. b
B. 1. T 2. T 3. F 4. T 5. T 6. T 7. T 8. T 9. F 
10. F
C. 1. ORACLE7 2. information 3. record 
4. requirements 5. failure 6. mechanism 
7. three 8. Security 9. ORACLE7 
10. schema
D. 1. A database application …………… 
in the database. 2. The two kinds ………. 
and reports. 3. Recovery is the ability 
…………… media failures.  4. ORACLE7 
handles ......……… does so automatically. 
5. Database theorists divided …………… 
views of  the data. 6. ORACLE7 gives you 
………. for users.
E. 1. A form application ……………… 
several at once. 2. Recovery is the ability 
………………… early and often. 3. With 
logging ..............…………….. recover the 
database. 4. The one thing ……………… 
is appropriate. 5.  Concurrency ………… 
so automatically. 6. One of  the central 
……………. it in your application.
F. Do yourself.
Hots: Do yourself.
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